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1 Cómo iniciar sesión con su cuenta de TI

Cómo iniciar sesión con su cuenta de TI
Para usar el software emulador TI-SmartView™ para las calculadoras MathPrint™,
necesitará iniciar sesión en su cuenta de TI.

1. Inicie el software emulador TI-SmartView™ para calculadoras MathPrint™.

Si esta es la primera vez que se inicia el software, se le pedirá que acepte la
Licencia, la Política de privacidad y los Términos de uso en línea.

Haga clic en Accept.

2. En el indicador de inicio de sesión, haga clic en LAUNCH SIGN IN.

Nota: Si necesita comprar una licencia para un solo usuario, haga clic en PURCHASE
LICENSE.

Esto abrirá la página de inicio de sesión de Texas Instruments en su navegador.
Complete el proceso de inicio de sesión con una cuenta de Google o con la
dirección de correo electrónico asociada con su cuenta de TI.



Después de validar su cuenta, un mensaje de éxito aparecerá en el navegador y se
abrirá el software.

Cómo ver la información de la licencia

Mientras está conectado/a, puede ver los detalles de su licencia.

▶ Diríjase a Help > License Info.

Información de la cuenta: Dirección de correo electrónico del usuario actual.

Expiración de la subscripción: Fecha de vencimiento para la licencia del software
actual.

Expiración de la sesión: Tiempo restante en la sesión actual.

Mientras el software está en uso, se conectará con el sistema de licenciamiento
cada 15 minutos. Si el usuario sale de línea en cualquier punto, el software se
ejecutará por siete días a partir de la última vez en que estuvo conectado.

Cómo desconectarse de su cuenta

1. Diríjase a Help > Sign Out.

2. Haga clic en SIGN OUT.

El software se cerrará y una pestaña del navegador abrirá la página de inicio de
sesión.

Cuando se cierra la sesión se guarda el estado actual y libera la licencia de regreso
al grupo de lugares disponibles. Cerrar el software usando File > Exit o el botón
Cerrar no cierra automáticamente la sesión de un usuario y libera la licencia.
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3 Introducción al software de emulador TI-SmartView™ para calculadoras MathPrint™

Introducción al software de emulador TI-SmartView™
para calculadoras MathPrint™
El software de emulador TI-SmartView™ para calculadoras MathPrint™ permite
mostrar el contenido de una calculadora gráfica a toda el aula.

Espacio de trabajo del emulador de calculadora

Permite:

• Seleccionar Emulador
– Seleccionar el emulador con el que trabajar.

– TI-30X Plus MathPrint™
– TI-30X Pro MathPrint™
– TI-30X Prio MathPrint™
– TI-30XB MultiView™
– TI-30XS MultiView™
– TI-34 MultiView™

• Ocultar/Mostrar la pantalla grande del emulador.
– Mostrar la vista de emulador completa con o sin un panel de

pantalla grande.
• Mostrar/ocultar la historia de pulsación de las teclas

– Muestra imágenes de las teclas pulsadas para facilitar el
seguimiento del proceso por parte de los alumnos.

• Abrir una ventana de captura de pantalla independiente
– De igual modo que utiliza la opción de captura de pantalla de TI

Connect™ CE, capture y guarde como archivos de ordenador.

Consulte: Cómo usar el espacio de trabajo del emulador de calculadora como ayuda
para mejorar las presentaciones en su aula.

Selección de su tipo de emulador
La primera vez que inicia TI-SmartView™ para MathPrint™ en su ordenador, aparece un
cuadro de diálogo de notificación.



Elija su tipo de emulador en el menú
desplegable y seleccione OK.
El emulador seleccionado se mostrará en la
primera presentación.

TI-SmartView™ para MathPrint™ siempre se inicia con el último estado del software.
Una vez accedido al software, puede cambiar el emulador predeterminado.

Consulte:Cómo seleccionar un tipo de emulador

El último tipo de emulador a la vista se convierte en el predeterminado y el
último tamaño de la ventana aparecerá conforme a su última configuración.

Consulte:Cómo cambiar el tamaño del panel de pantalla grande del emulador TI-
SmartView™

Pantalla del emulador de calculadora

Introducción al software de emulador TI-SmartView™ para calculadoras MathPrint™ 4



5 Introducción al software de emulador TI-SmartView™ para calculadoras MathPrint™

Nota: Las imágenes de esta guía pueden ser diferentes dependiendo del emulador que
haya seleccionado.



Cómo usar el espacio de trabajo del emulador TI-
SmartView™ para calculadoras MathPrint™
El espacio de trabajo del emulador de calculadora TI-SmartView™ para MathPrint™
contiene herramientas que podrá utilizar para introducir cálculos .
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7 Cómo usar el espacio de trabajo del emulador TI-SmartView™ para calculadoras MathPrint™

Partes del espacio de trabajo del emulador TI-SmartView™

Barra de menús - utilice estos menús para llevar a cabo todas las funciones del
emulador, entre ellas:

• File (Archivo): permite salir • Actions (Acciones): permite realizar
tareas, por ejemplo, capturar pantallas

• Edit (Edición): contiene
teclas de copia y cambio de
fuentes

• Help (Ayuda): abre el sistema de ayuda y
muestra vínculos

• View (Ver): permite cambiar
las pantallas

Nota: La mayor parte de las acciones de estos menús se puede realizar con los
iconos de la barra de herramientas.

Barra de herramientas: utilice los iconos de la barra de herramientas para:
• Seleccionar otro modelo de calculadora
• Cambiar alternativamente la presentación de pantalla grande y mostrar u

ocultar el historial de pulsaciones de teclas
• Capturar la pantalla actual del emulador

Seleccionador de posición del emulador y de la barra de herramientas

• Posición del emulador a izquierda/derecha - permite situar el
emulador en la parte izquierda o derecha de la pantalla de la calculadora
gráfica, alternativamente. Es una opción muy cómoda cuando se utiliza un
proyector de pizarra interactiva.

• Barra de herramientas arriba/abajo - permite situar la barra de
herramientas en la parte superior o inferior de la pantalla, alternativamente
Es una opción muy cómoda cuando se utiliza un proyector de pizarra
interactiva.

Nota: Puede cambiar la posición y/o la distribución visual de los elementos para
optimizar el acceso, especialmente cuando se utiliza una pizarra interactiva.

Panel del emulador - utilice este panel para mostrar el emulador completo o
solamente el teclado del emulador.

Panel de pantalla grande/Panel del historial de pulsaciones de teclas: utilice este
panel para mostrar una versión grande de la pantalla de la calculadora y/o el
historial de pulsaciones de teclas.
Puede elegir entre las opciones de presentación siguientes:



• Large Display Screen only (Solo
pantalla grande)

• Key press history only (Solo historial
de pulsaciones de teclas)

• Large Display Screen + Key Press
History (Pantalla grande +
Historial de pulsaciones de
teclas)

• Hide Large Display Screen (Ocultar el
panel de pantalla grande)

Cambiar tamaño de los paneles - haga clic y arrastre la barra vertical, situada
junto al borde de un panel, para cambiar su tamaño.

Cómo utilizar el teclado del emulador TI-SmartView™
El puntero del ratón actúa de la misma manera a como lo hacen los dedos cuando
pulsan las teclas del ordenador.

Haga clic en las teclas del emulador TI-SmartView™ para MathPrint™ exactamente igual
que si pulsara las teclas de la calculadora científica.

Pulse y mantenga pulsada una tecla de flecha para desplazar el cursor de forma
continuada.

Cuando utilice una tecla de flecha para mover el cursor, manténgala pulsada; el cursor
se desplazará de forma ininterrumpida sin necesidad de tener que pulsar la tecla varias
veces. En el historial de pulsaciones de teclas, el icono para una tecla de flecha de
repetición se indica con un símbolo de reloj situado en una de sus esquinas.

Al pulsar varias veces una tecla de flecha de una fila aparece una tecla con un
contador de repeticiones.

Cuando se pulsa varias veces una tecla de flecha en una fila, el historial de pulsaciones

de teclas muestra una tecla de flecha con un número que representa el número
de veces que se ha pulsado la tecla.

Cómo arrastrar y soltar pantallas de una aplicación a otra
Puede utilizar el software TI-SmartView™ para calculadoras MathPrint™ para arrastrar
cualquier captura de pantalla a otra aplicación en la que quiera soltarla y pegarla.

Las pantallas del emulador TI-SmartView™ para calculadoras MathPrint™ que puede
arrastrar y pegar incluyen las siguientes:

• La pantalla que aparece por encima del teclado en el panel del emulador

• Panel de pantalla grande

• Capturas de pantalla guardadas o no guardadas en espacio de trabajo de captura
de pantalla
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9 Cómo usar el espacio de trabajo del emulador TI-SmartView™ para calculadoras MathPrint™

Cómo restablecer el emulador
Para restablecer el emulador:

1. Haga clic en Actions (Acciones).

2. Haga clic en Reset Emulator (Restablecer emulador).

3. Haga clic en Reset (Restablecer).

Cuando se restablece el emulador:

• Se sobrescribe el estado actual del emulador

• Se limpia el historial de pulsaciones de teclas



Cómo guardar y cargar un emulador MathPrint™Estado
Cuando se guarda el estado del Emulador MathPrint™, se crea un archivo donde se
guardan los valores de configuración del emulador junto con todos los cambios
realizados.

Por ejemplo, suponga que ha preparado una presentación para una clase introduciendo
datos en el editor de datos y funciones en f(x) y g(x). Si ha guardado los cambios en el
archivo de estado del emulador, solo tendrá que cargar el archivo con la presentación.
A continuación, y si desea crear otras presentaciones para otras clases, solo tendrá que
crear tantos archivos de estado del emulador como necesite.

Nota: El archivo de estado del emulador no incluye el historial de pulsaciones de teclas,
las pantallas capturadas ni el tamaño del emulador. Recuerde que los archivos de
estado del emulador MathPrint™ pueden ser de gran tamaño. Póngase en contacto con
su departamento de informática si la capacidad de almacenamiento es un problema.

Para guardar el estado del emulador MathPrint™

La gestión, almacenamiento y carga de archivos de estado del emulador solo está
disponible para cada emulador MathPrint™. El archivo de estado del emulador TI-30X
Plus MathPrint™ solo puede cargarse en el emulador TI-30X Plus MathPrint™.

Nota: El archivo de estado del emulador TI-30X Pro MathPrint™ solo puede cargarse en
el emulador TI-30X Pro MathPrint™.

1. Haga clic en Actions > Save Emulator State... (Acciones > Guardar estado del
emulador).

2. En el cuadro de diálogo:

Cómo usar el espacio de trabajo del emulador TI-SmartView™ para calculadoras MathPrint™ 10



11 Cómo usar el espacio de trabajo del emulador TI-SmartView™ para calculadoras MathPrint™

a) Vaya a la carpeta en la que desee guardar el archivo de estado del emulador
MathPrint™.

b) Escriba un nombre de archivo. Utilice nombres descriptivos del estado del
emulador MathPrint™.

Nota: El archivo de estado del emulador MathPrint™ tiene un nombre de
archivo preconfigurado con la extensión *.s3l que indica el estado del emulador
de la calculadora TI-30X Plus MathPrint™ creado por el software de emulador
TI-SmartView™ MathPrint™. La extensión del estado del emulador de la
calculadora TI-30X Pro MathPrint™ es *.s3r. La extensión del estado del
emulador de la calculadora TI-30X Prio MathPrint™ es *.s3i.

c) Haga clic en Save (Guardar).

Cómo cargar el estado del emulador MathPrint™

Los archivos de estado del emulador MathPrint™ son específicos de cada modelo de
calculadora, de ahí que solo pueda cargarse el archivo de estado para el modelo de
calculadora que esté activa.

1. Haga clic en Actions > Load Emulator State (Acciones > Cargar estado del emulador).

2. En el cuadro de diálogo:

a) Desplácese hasta la carpeta que contenga el archivo de estado del emulador.

Nota: La pantalla solo contendrá los archivos de listado del emulador
MathPrint™ correspondientes al modelo de calculadora activa.

b) Haga clic en el nombre del archivo de estado MathPrint™ para resaltarlo.
c) Haga clic en Open (Abrir).



Cómo seleccionar una opción de visualización
Puede personalizar el modo de visualización para ocultar o mostrar los paneles
opcionales, o cambiar el tipo de información que debe aparecer en cada uno. De forma
predeterminada, el software de emulador TI-SmartView™ para calculadoras
MathPrint™ muestra el espacio de trabajo del emulador de calculadora en pantalla
grande.

Cómo mostrar la pantalla de la calculadora

1. Haga clic en
para
ocultar el panel de
pantalla grande.

2. Vuelva a hacer clic en para
mostrar el panel de pantalla grande.

Cómo seleccionar un tipo de emulador

Haga clic en la flecha abajo del icono para seleccionar un tipo de emulador.
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13 Cómo usar el espacio de trabajo del emulador TI-SmartView™ para calculadoras MathPrint™

Cada tipo de emulador se corresponde con un modelo de calculadora.



Cómo cambiar la placa frontal de la calculadora

Para cambiar la placa frontal:

1. Haga clic en View (Ver).

2. Desplace el puntero hasta Calculator Faceplate (Placa frontal de calculadora).

3. Haga clic en el nombre de la placa frontal que prefiera.

Clara Oscura Esquema

Cómo mostrar y ocultar el historial de pulsaciones de teclas

Haga clic en para mostrar u ocultar el historial de pulsaciones de teclas.
Haga clic en CLEAR (LIMPIAR) que aparece en el panel junto a Key Press History
(Historial de pulsaciones de teclas) para borrar el historial.

Haga clic aquí y
arrastre para
cambiar el
tamaño del
panel del
historial de
pulsaciones de
teclas.

Haga clic aquí
después de
seleccionar
teclas para
copiar la fuente
como gráficos.

Haga clic aquí
para borrar el
historial de
pulsaciones de
teclas.
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15 Cómo usar el espacio de trabajo del emulador TI-SmartView™ para calculadoras MathPrint™

Cuando se pulsa la tecla para limpiar, se abre el cuadro de información siguiente:

Cómo copiar el historial de pulsaciones de teclas en otra aplicación
Puede copiar todo o una parte seleccionada del historial de pulsaciones de teclas en
otra aplicación, por ejemplo, en un procesador de textos. También puede copiar los

gráficos de tecla tal y como aparecen en el panel del historial, o las pulsaciones
de teclas como caracteres de texto fuente2U3.

Nota: Al copiar claves como caracteres de texto de fuente, sólo se pegan las fuentes de
clave primaria. Solo se pegan las teclas de texto fuente principales. Las teclas de texto
fuente secundario no se pegan mediante la función de copia como texto fuente de TI-
SmartView™. Puede insertar anualmente las funciones secundarias utilizando la fuente
instalada. Se trata de la fuente que se instala automáticamente en el ordenador al
instalar el software TI- SmartView™ para calculadoras MathPrint™. La fuente contiene
todas las teclas de TI-30X Plus más un subconjunto de teclas de fuente de TI-30X Pro.

Cómo copiar teclas como gráficos o caracteres de fuente

1. Seleccione las teclas que desee copiar.
Para seleccionar teclas del panel del historial de pulsaciones, utilice uno de los
métodos siguientes:

Tecla Método
– Una tecla cualquiera: Haga clic en la tecla en cuestión.

– Varias teclas: Haga clic en una tecla.
Pulse y mantenga pulsada la tecla Ctrl
del teclado.
Haga clic en las demás teclas que
desee seleccionar.

– Varias teclas de una secuencia: Haga clic en una tecla.
Pulse y mantenga pulsada la tecla
Mayús del ordenador.
Pulse otra tecla.
Nota: Con este método seleccionará
las dos teclas en las que ha hecho clic y
todas las demás situadas entre ambas.



Tecla Método
– Todas las teclas: Haga clic en una tecla.

Haga clic con el botón derecho del
ratón.
Haga clic en Select All (Seleccionar
todo).
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17 Cómo usar el espacio de trabajo del emulador TI-SmartView™ para calculadoras MathPrint™

Nota: Este es el aspecto de una tecla antes y después de seleccionarla.

Antes: Después:

2. Seleccione las teclas

3. Haga clic en Copy (Copia) (para copiar las teclas como gráficos).

o

Haga clic en Copy As Font (Copiar como fuente) (para copiar las teclas como
caracteres de fuente principales)2U3.

4. Cambie a otra aplicación.

5. Pegue las teclas en la ubicación apropiada.

Nota:

• Otra opción consiste en arrastrar las teclas seleccionadas como gráficos hasta la
otra aplicación.

• Puede cambiar el tamaño de los gráficos de las teclas después de pegarlos en la
nueva aplicación.

• En algunas aplicaciones, los caracteres pegados pueden aparecer con la fuente de
la ubicación de destino, por lo que pueden mostrar un aspecto distinto al de las
teclas de calculadora científica. Si es necesario, aplique la fuente de clave de
calculadora adecuada a los caracteres. Consulte el archivo de ayuda de la aplicación
de destino que esté utilizando para obtener información sobre como aplicar la
fuente a los caracteres.



Cómo cambiar el tamaño del panel de pantalla grande del emulador
TI-SmartView™
En el panel de pantalla grande, haga clic y arrastre el borde de un panel para cambiar
su tamaño.

Nota: Todas estas acciones se realizan de izquierda a derecha, salvo el historial de
pulsaciones de teclas cuyo tamaño se aumenta o reduce hacia arriba o abajo.

Posiciones del emulador y de la barra de herramientas
Posición del emulador a izquierda/derecha: - permite situar el emulador
en la parte izquierda o derecha de la pantalla de la calculadora
científica, alternativamente. Es una opción muy cómoda cuando se
utiliza un proyector de pizarra interactiva.

Barra de herramientas arriba/abajo: - permite situar la barra de
herramientas en la parte superior o inferior de la pantalla,
alternativamente Es una opción muy cómoda cuando se utiliza un
proyector de pizarra interactiva.
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19 Cómo usar el espacio de trabajo del emulador TI-SmartView™ para calculadoras MathPrint™

Always in Front (Siempre visible)
Seleccione esta opción del menú View (Ver) para que las ventanas de emulador TI-
SmartView™ para calculadoras MathPrint™ se mantengan siempre delante de cualquier
otra ventana del software de ordenador que esté abierta, exactamente igual que si
tuviera la calculadora sobre la pila de papeles de la mesa de trabajo. Deje que la
ventana esté "siempre visible" en el lugar del escritorio del ordenador que le resulte
más cómodo.

Cuando quiera que la ventana deje de estar "siempre visible", quite la marca de
selección de la opción del menú View (Ver). Esta característica carece de icono en la
barra de herramientas, por lo que el único indicio de que está activa es la marca de
selección en el menú.

Notas:

Tanto la ventana del espacio de trabajo del emulador TI-SmartView™ para calculadoras
MathPrint™ como la de captura de pantalla pueden estar "siempre visibles" e
intercambiar su lugar en primer plano dependiendo de su posición.

No es aconsejable utilizar la opción "Siempre visible" en modo de ventana completa, ya
que ocultará cualquier otra ventana de TI-SmartView™ para calculadoras MathPrint™.



Cómo utilizar la herramienta de captura de pantalla
La herramienta de captura de pantalla del emulador TI-SmartView™ para MathPrint™
permite capturar la imagen actual que muestra la pantalla de la calculadora científica.

Para utilizar la captura de pantalla:

▶ Haga clic en el icono de la barra de herramientas.

Esta acción abre esta ventana:

Cómo utilizar la herramienta de captura de pantalla 20
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Partes del espacio de trabajo de captura de pantalla

Capturar Haga clic en este icono para toma una captura de pantalla del
emulador.
Actions (Acciones) > Capture Screen (Capturar pantalla)
Nota: De forma predeterminada se añade automáticamente
un borde a cada imagen que se captura; si desea eliminar el
borde, haga clic en View (Ver) > Hide Screen Capture Borders
(Ocultar bordes de captura de pantalla). (Si tiene varias
imágenes, esta acción borrará el borde de todas ellas).
Con la herramienta de captura de pantalla puede:
• capturar hasta 44 pantallas a la vez, (si desea capturar

más imágenes, deberá borrar algunas de la ventana de
captura de pantalla)

• almacenar automáticamente capturas de pantalla, que
permanecerán en la memoria hasta que se cierre la
ventana principal de TI-SmartView™ para calculadoras
MathPrint™.

Cuando se cierra la herramienta de captura de pantalla
aparece un mensaje solicitando que guarde las pantallas
capturadas. Puede iniciar una nueva sesión de captura de
pantallas durante una sesión de TI-SmartView™ para
calculadoras MathPrint™.

Guardar Haga clic en el icono para almacenar las capturas de pantalla
seleccionadas.
File (Archivo) > Save As (Guardar como)

Copy Haga clic en el icono para copiar las capturas de pantalla
seleccionadas en el portapapeles.
Edit (Edición) > Copy (Copiar)

Borrar Haga clic en el icono para eliminar las capturas de pantalla
seleccionadas.
Edit (Edición) > Delete (Borrar)

Cambiar tamaño Deslice el punto a lo largo de la barra para ajustar el tamaño
de vista previa de la captura de pantalla actual.
View (Ver) > Scale Screen Captures (Ajustar escala de capturas
de pantalla)
Nota: Las pantallas se guardan con el porcentaje de la vista.

Cambiar nombre Cambie el nombre de una captura de pantalla resaltando el
título y escribiendo uno nuevo.

View Lugar para examinar las capturas de pantalla.

Cómo arrastrar y soltar pantallas de una aplicación a otra
Puede utilizar el software TI-SmartView™ para calculadoras MathPrint™ para arrastrar
cualquier captura de pantalla a otra aplicación en la que quiera soltarla y pegarla.



Las pantallas del emulador TI-SmartView™ para calculadoras MathPrint™ que puede
arrastrar y pegar incluyen las siguientes:

• La pantalla que aparece por encima del teclado en el panel del emulador

• Panel de pantalla grande

• Capturas de pantalla guardadas o no guardadas en espacio de trabajo de captura
de pantalla

Cómo utilizar la herramienta de captura de pantalla 22
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Mapeo de teclado del ordenador
Para pulsar una tecla puede utilizar el teclado del ordenador, en lugar de la tecla que
aparece en la imagen del teclado del emulador de TI-SmartView™.

Cómo utilizar el teclado del ordenador
Para pulsar una tecla del emulador utilizando el teclado del ordenador, busque en la
tabla siguiente la tecla de ordenador asociada con la tecla de emulador.

• TI-30X Pro MathPrint™ or TI-30X Plus MathPrint™ métodos abreviados de teclado

• TI-30X Prio MathPrint™ métodos abreviados de teclado

• TI-30XS-30XB MultiView™ métodos abreviados de teclado

• TI-34 MultiView™ métodos abreviados de teclado



TI-30X Pro MathPrint™ or TI-30X Plus MathPrint™

Ejemplo: Para mostrar la pantalla de modo en el emulador, pulse [W] en el teclado del
ordenador como se indica en la tabla siguiente.

TI-30X Pro MathPrint™ métodos abreviados de teclado:

TI-30X Plus MathPrint™ métodos abreviados de teclado:
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25 Mapeo de teclado del ordenador

*Nota:

En el teclado del ordenador MAC,

- Pulse [Delete] paraJ.
- Pulse [Backspace] para-.



TI-30X Prio MathPrint™

Ejemplo: Para mostrar la pantalla de modo en el emulador, pulse [W] en el teclado del
ordenador como se indica en la tabla siguiente.

TI-30X Prio MathPrint™ métodos abreviados de teclado:
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*Nota:

En el teclado del ordenador MAC,

- Pulse [Delete] paraJ.
- Pulse [Backspace] para-.



TI-30XS/30XB MultiView™

Ejemplo: Para mostrar la pantalla de modo en el emulador, pulse [W] en el teclado del
ordenador como se indica en la tabla siguiente.

TI-30XS MultiView™ métodos abreviados de teclado:
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29 Mapeo de teclado del ordenador

*Nota:

En el teclado del ordenador MAC,

- Pulse [Delete] paraJ.
- Pulse [Backspace] para-.



TI-34 MultiView™

Ejemplo: Para mostrar la pantalla de modo en el emulador, pulse [W] en el teclado del
ordenador como se indica en la tabla siguiente.
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*Nota:

En el teclado del ordenador MAC,

- Pulse [Delete] paraJ.
- Pulse [Backspace] para-.



General Information
Online Help
education.ti.com/eguide

Select your country for more product information.

Contact TI Support
education.ti.com/ti-cares

Select your country for technical and other support resources.

Service and Warranty Information
education.ti.com/warranty

Select your country for information about the length and terms of the warranty or
about product service.

Limited Warranty. This warranty does not affect your statutory rights.

Texas Instruments Incorporated

12500 TI Blvd.

Dallas, TX 75243
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